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It’s hard to believe, but another year has passed,
and the holiday season is once again upon us. I’m in
the United States, and I’m writing this just before
Thanksgiving, the annual holiday that usually marks
the start of the holiday season (if you discount the
fact that retailers are pushing out holiday displays
earlier and earlier each and every year).

It’s an American “tradition” to recount the things that
we are thankful for, in association with Thanksgiving.
Also, the closer we come to the Christian holiday of
Christmas, many of us who observe that holiday
become increasingly overcome with “Christmas
Spirit.” People typically become a bit more tolerant, a
bit more charitable, and quite a bit friendlier.

It’s a good idea to reflect on our lives from time to
time, and to list the things that we are thankful for. In
the U.S., the winter holiday season is the time that’s
traditionally viewed as the most appropriate time to
enumerate the things that we are thankful for. So,
here are some of the things that I am thankful for
during this holiday season.

I am thankful for my wife and child, both of whom
keep me grounded and bring me so many joys in
life.

I am thankful for being able to work for a living wage
at a job I truly enjoy. I am also thankful for the
countless number of lives that I’ve touched over my
career, and the positive impact that I have had on
their lives.

I am thankful for Texstar for creating PCLinuxOS,
keeping me free from the “usual” trappings that
plague other operating systems, such as malware,
viruses, crapware, spyware and security
vulnerabilities. I can use my computer(s) with peace
of mind that everything is going to come tumbling
down around me and my data. I’m also thankful that
PCLinuxOS is so much more stable.

I am thankful for my relatively good health.

I am thankful for my PCLinuxOS “family.” Over the
years, I’ve met some really interesting and awesome
people from all around the world, many of whom I

consider to be great friends – even though we’ve
never met, face to face.

I am thankful for my traditional family, even with all
the drama baggage that traditional families tend to
carry.

I am thankful for my friends and the ways that they
enrich my life.

I am thankful for being able to do things that make
my life so much more rewarding, fulfilling and
enchanting. These include things like bicycle riding,
hunting, fishing, woodworking, and photography.

I am thankful for the abilities to write articles for the
magazine, and the skills to produce The PCLinuxOS
Magazine month after month.

So, until next month, I bid you peace, happiness,
prosperity and serenity. Oh – and Happy Holidays!

Ryan The Lion and me, on Halloween.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

Welcome From The Chief Editor

http://pclosmag.com/htdig
http://www.opensource.org/
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by Paul Arnote (parnote)

If you were a Commodore computer user in the mid
1980s, you might remember QuantumLink, the
online service for Commodore 64 and 128 users.
You might also remember OMS, or Online
Messaging Service, more commonly known as
People Connection. This was a “Plus” service for
QuantumLink users that allowed for real time chats
with other users who were online at the same time,
albeit at an extra cost.

QuantumLink, as it appeared on a Commodore 64 in
1985. Looks a bit like Windows 8, huh?

Fast forward a few years, and QuantumLink became
AOL (America Online). Its user base had been
expanded to the still-burgeoning IBM PC market,
capitalizing on the meteoric rise of Microsoft
Windows. In May 1997, AOL released AIM, or AOL
Instant Messenger. This allowed non-subscribers to
AOL’s service to log in and speak to anyone else
who had the AIM software installed on their
computer, as well as AOL users.

Within the next year (March, 1998), Yahoo! launched
their version, called Yahoo! Messenger. This

provided some competition for the instant
messaging market that AOL had created. Both
services (AOL and Yahoo! instant messaging) are
still around, and alive and kicking. AOL has since
been purchased by Time Warner, and the term
“instant messenger” is a service mark of Time
Warner. As such, that led to GAIM (GTK+ AOL
Instant Messenger) changing its name to Pidgin.

I remember it all very well. Up until that point, the
only way to “chat” with other users located in other
parts of the world was either via email (and wait for
them to respond), or via IRC, or Internet Relay Chat.
While it was/is possible to have a private chat with
another IRC user, most conversations occurred in an
open “room,” kind of like at a cocktail party.

The instant messaging services took off like a
firestorm. Now users could have private
conversations with other users with ease. “Buddies”
lists and “Friends” lists were the new buzzwords.

Now, fast forward to October, 2014. YouCanToo
installed an XMPP server, called OpenFire, on his
server. With that, PCLOS-Talk, a private instant
messaging network just for PCLinuxOS users was
born.

Users can connect to PCLOS-Talk using either
Pidgin or Kopete. Let’s go over how to do just that.
We’ll focus on setting up Pidgin. The process for
setting up Kopete will be slightly different, but similar.

Getting Connected With Pidgin

If you’re not familiar with it, Pidgin is open source
software that excels at connecting to instant
messaging services, even if they use different
protocols. With Pidgin, you can connect to PCLOS-
Talk, and have real time, private chats with other
PCLinuxOS users across the globe. If the other user
isn’t currently online, your messages to them will be
displayed the next time they log in.

My Xfce desktop, with Pidgin logged into PCLOS-Talk.
I’ve also got three conference “rooms” opened.

Mind you, this isn’t going to be a full-blown Pidgin
“How To” tutorial, even though there is a good
amount of “How To” in here. Rather, what we’ll focus
on here is how to get the most out of PCLOS-Talk.

Connect connections in one
convenient location!

All your
PCLinuxOS

PCLOS-Talk: Our Own Instant Messaging Service

http://pclosmag.com/links.html
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When you first start off, you’ll not have any other
users listed in your “Buddies” list. That doesn’t make
it easy to chat with anyone. So, let’s fix that. Under
the Accounts menu in Pidgin, hover over your
PCLOS-Talk account, and select “Search for
users…” from the menu that pops up. Accept the
defaults in the next dialog box, and click on OK. You
should now get a dialog box like the one shown
above (previous page, bottom of third column). If
you know your user’s name, you can type it into the
search field. Otherwise, just put “*” (an asterisk) in
the search field, and make sure that the checkboxes
in front of “Username” and “Name” are checked.
Now, click OK.

Click on the users in the list (one at a time) you want
to add to your Buddies list, and click on the “Add”
button. When you’ve added all the Buddies you
want, click on the “Close” button.

What should happen next is that the users you want
to add to your Buddies list will be sent notification
that you’ve added them to your Buddies list, and
they have the opportunity to authorize you adding
them to your Buddies list, or deny it. For what it’s

worth, it works both ways. If someone you don’t
know (or you don’t really want to chat with) adds you
to their Buddies list, you also have the same
opportunity to authorize or deny them adding you to
their Buddies list.

Meanwhile, the user(s) you added will show up in
your Buddies list, looking quite like the image above.
There will be the red circle with a line through it and
the words “Not Authorized” under the user’s name,
indicating they have not yet authorized you adding
them to your Buddies list. If they are already online,
the authorization message should appear almost
immediately. Otherwise, the next time they log into
PCLOS-Talk, they will have the opportunity to
authorize or deny you adding them to your Buddies
list.

Once you have some users listed in your Buddies
list, you can have private chats. After all, this is

where instant messaging shines. Just double
clicking on a user’s name in your Buddies list will
open a window, similar to the one above. You type
your half of the conversation in the lower window
pane, and the entire conversation appears in the
upper window pane.

Now, if you read the caption under the full screen
capture of my Xfce desktop above, you’ll notice that
I made mention of “rooms.” Yes, even with instant
messaging, you can have chat rooms, conferences,
group chats, or whatever else you want to call them.

Under the Tool menu (in Pidgin’s main window),
select “Rooms List.” Accept the default values in the
next dialog. Then, you should be presented with a
window similar to the one shown above. Click on the
“room” you want to join, and select the “Join” button.
(Note: the room window may not be immediately
visible, as it may be just beneath the Rooms List
window. The new chat windows tend to appear
centered on the screen, so if you join multiple
rooms, they may be stacked one on top of another.
They can easily be separated just by moving the
windows about on your screen.) When you’ve
finished joining all the rooms you want to join, select
the “Close” button.

PCLOS-Talk: Our Own Instant Messaging Service
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The “pclosmag room”

The right top pane shows the users currently in the
room, while the top left pane shows the
conversations that are taking place. The bottom
pane is where you type/enter your replies. “Rooms”
are great for conversations/meetings where you
want the input from more than one user.

But sometimes, you may want to keep your “group
chats” private. You may not want just anyone to pop
in, because you may be discussing private or
sensitive topics. So … can you set up a private
room? You sure can!

From Pidgin’s main window, select Buddies > Join
chat….

A dialog similar to the one above (bottom of previous
column) will be displayed. Enter the name of the
room you want to join in the “Room” field. If the room
doesn’t already exist, it will be created.

If you want the room to be private, you will need to
select the “Configure Room” button.

Scroll down and remove the checkmark in front of
the “List Room in Directory” option to make your
“room” private. Also, if you want to require a
password to enter the room, scroll down a little more
to select that option, and then enter the password
users will have to enter to gain entry.

Now that you have your private room setup, you can
send an IM to each individual you want to join you
there, or you can just select Conversation > Invite…
from the menus in your new room’s chat window,
and send an invite to each user without opening up
a separate IM window.

You can also set your overall privacy by selecting
Tools > Privacy from Pidgin’s main window. You will
see a dialog like the one above, and you can set
your privacy up so that only people on your Buddies
list can contact you, block all users, etc. The default
setting is to “Allow all users to contact me.”

If you have logging enabled, you can view the
previous conversations you’ve had with users in
your Buddies list. The easiest way (not the only way)
is to right click on the user’s name in your Buddies
list, and select “View Log” from the context menu. A
dialog similar to the one displayed above will be
shown. The various conversations you’ve had with
that user will populate the left window pane, listed in
chronological order. The right window pane will
display the conversation that is selected in the left
window pane.

PCLOS-Talk: Our Own Instant Messaging Service
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Summary

This should be more than enough to get you started
using PCLOS-Talk. The XMPP server that
YouCanToo has installed has a LOT more features,
like being able to share files among each other.
Plus, you should rest assured that unless there is
something in the OpenFire software that enables
interception, your conversations on PCLOS-Talk are
free from spying by the NSA, GCHQ and other
nefarious government organizations looking to spy
on your every thought and move.

YouCanToo has, once again, amazed the
PCLinuxOS community with not only his abilities to
run and manage so many services for PCLinuxOS
users, but also with his generosity. Every
PCLinuxOS user benefits from YouCanToo’s
generosity, whether they realize it or not.

Thank you, YouCanToo, for helping to make
PCLinuxOS truly unique among Linux distros.

Screenshot ShowcaseScreenshot Showcase

Posted by weirdwolf, November 23, 2014, running LXDE.

PCLOS-Talk: Our Own Instant Messaging Service

http://www.pclosusers.com/services-signup.php
http://pclinuxos.com/?page_id=188
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by Meemaw

This one is pretty easy. It resembles a note taped to
a surface with clear tape.

Open Inkscape and set your document properties. I
used a letter sized page, in landscape orientation. It
seems to be easier if you change your background
from white to something a bit darker so you can see
what you’re doing. In Document Properties, one of
the choices is background color. From the Document

Properties window, click on the colored line behind
the word Background, and the small window will
appear (bottom, left):

I changed mine to a medium grey. It will be easier to
see what I’m doing.

Next, draw a rectangle, white fill and no stroke. In
the Path menu, click Object to Path while your
rectangle is selected. Change to the Paths tool
(second from the top at left). On each end of your
rectangle add five nodes by double-clicking on the
end line five different times. Grab alternating nodes
and move them inward to create a “cut tape” effect
at each end. Don’t worry, it doesn’t have to be
perfect, and you can add more if you wish.

When you get your “tape” the way you want it, go to
Properties and set the opacity down to 30 or 35, or
whatever looks good to you. Resize it (depending on
how big you made it when you started), then
duplicate it and separate the two.

Create a new rectangle for the note itself. I made
mine yellow, but you can make it any color you want.
You can arrange your tape pieces now, or wait until
you are finished.

Not all pieces of paper are wrinkle free, so let’s put
in a shadow that makes it look like the paper is
curling a bit at one side. Using your Bezier tool with
the width set about 10, draw a line similar to the one
shown below.

Inkscape Tutorial: Taped Note
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Zoom in on your corner and move the line up to the
corner of the paper.

Send the line underneath the paper, and set the
Blur at 5.

The bigger the shadow you want/need, the longer
and less angled you should make your lines.

Now we want to do our note. Click on the Text tool
at left, click on the yellow “paper” where you want
your note and type. Now click on the Text
Formatting tool at the top of your window and
format the text. I used a font called !Paul Maul, but
you should use whatever you like (center, top). Save
your work.

From here, you can personalize your project. You
can change the background back to white and save
just the note and tape or do something different. I
angled my note and tape pieces a bit, and then put
one of our favorite wallpapers behind it. Remember
to make sure your tape pieces have been moved
above all other items so they show as being over
both the paper and the writing. Save your work and
export your project.

Available in the following desktops:

KDE LXDE Xfce

Openbox Gnome

Enlightenment e17

The PCLinuxOS Magazine

Created with Scribus

Inkscape Tutorial: Taped Note

http://www.pclinuxos.com
http://www.scribus.net
http://www.linuxforums.org/forum/
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Defending Your Rights

In The Digital World

Visit.
Contribute.

Build.

The PCLinuxOS
Knowledge Base

It Belongs To YOU!

http://www.pclinuxos.com
https://www.eff.org/
http://pclinuxoshelp.com/index.php/Main_Page
http://www.linuxquestions.org
http://www.commandlinefu.com
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Ingredients:

Meat Loaf
3 slices bread, torn into small pieces
½ cup milk
1 ½ lb lean (at least 80%) ground beef
8 slices bacon, crisply cooked and crumbled
1 cup finely shredded sharp Cheddar cheese (4 oz)
¼ cup dill pickle relish
½ cup finely chopped onion
1 clove garlic, finely chopped
1 egg, slightly beaten

Topping
⅓ cup ketchup
1 tablespoon packed brown sugar

Directions
• Heat oven to 350°F. Line 9x5-inch loaf pan with foil;
spray foil with cooking spray.

• In large bowl, mix bread and milk. Let stand 5
minutes to absorb milk. Add beef, all but 2
tablespoons of the bacon, the shredded cheese,
relish, onion, garlic and egg. Mix until well combined.
Shape mixture into 8x4-inch loaf. Place in pan.

• In small bowl, stir together Topping ingredients.
Spread on top and sides of loaf. Top with reserved 2
tablespoons crumbled bacon.

• Bake uncovered 1 hour to 1 hour 15 minutes or
until meat thermometer inserted in center of loaf
reads 160°F. Cool 10 minutes.

• Cut meat loaf into slices to serve. Top with desired
burger toppings, such as pickle relish, ketchup and
mustard.

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxos-magazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Reach Us On The Web

The
PCLinuxOS
Magazine

Created with
Scribus

PCLinuxOS Recipe Corner

Bacon Cheeseburger Meat Loaf

http://groups.google.com/group/pclinuxos-magazine
http://pclosmag.com
http://www.pclinuxos.com/forum/index.php?board=34.0
http://www.fsf.org
http://www.linfx.com
http://www.scribus.net
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La PCLOS La PCLOS Heart and soul of Texstar
La PCLOS La PCLOS Sing it near and sing it far
La PCLOS La PCLOS Using it how smart we are
La PCLOS La PCLOS Play it on your guitar

La PCLOS La PCLOS Many choices you will find
La PCLOS La PCLOS It is so well designed
La PCLOS La PCLOS Download the desktop of your choice
La PCLOS La PCLOS Use it now and rejoice

La PCLOS La PCLOS Linux gives you freedom
La PCLOS La PCLOS Soon an expert you'll become
La PCLOS La PCLOS Has the best magazine
La PCLOS La PCLOS Reading it will be routine

La PCLOS La PCLOS Join the forum for merriment
La PCLOS La PCLOS There is never discontent
La PCLOS La PCLOS No viruses will appear
La PCLOS La PCLOS Fun and happiness and cheer

MP3 OGG

ms_meme's Nook: La PCLOS

http://pclosmag.com/html/Issues/201412/files/lapclos.mp3
http://pclosmag.com/html/Issues/201412/files/lapclos.ogg
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by YouCanToo

Google has Google Drive. Microsoft has OneDrive.
Dropbox, SpiderOak, Minus, Wuala (before it
became a strictly pay service) and lots of other
“cloud storage” services have become popular and
attractive to users on virtually all platforms. They
give users access to their files and “stuff,” regardless
of where they are, on a wide variety of devices.

Of course, there are security concerns with all cloud
storage providers. As with any storage medium that
you don’t have absolute control over, there will
always be security concerns. With some providers,
there is the concern that they are a direct conduit to
government sponsored spying agencies and groups,
like the NSA and GCHQ. As obvious as it might
sound, it definitely bears repeating that the solution
is to keep sensitive documents and files on local
storage medium that you control.

With that in mind, let’s introduce you to PCLOS-
Cloud, the newest offering of services, just for
PCLinuxOS users. Initial plans allow for a generous
5 GiB of storage space for your files and “stuff.”

Using PCLOS-Cloud

We first need to install some software from Synaptic
Package Manager.

Install the following packages, along with any
dependencies required.

1. mirrall-common
2. owncloud-client

Once installed we can proceed to setting up an
PCLOS-Cloud account.

Sign Up for a PCLOS-Cloud account at
http://pclosusers.com/services-signup.php.

When you receive your PCLOS-Cloud confirmation
email, you will then be able to set up your owncloud
client.

You will find the owncloud-client program in your PC
menu --> Internet --> ownCloud-Client.

NOTE: On several of my machines, I had to add an
entry for the OwnCloudclient as it was not done
automatically. If this is the case, for you, and you
are running KDE, right click on the PC icon and
select Edit Applications. Click on Internet then
click on New Item. In the window that opens,
enter ownCloudclient and press OK.

In the editor window, in the area labeled
Command, enter “owncloud” without the quotes.
Now click on Save. Your system will now be
updated. You can now close the Menu Editor
window. Now you will find the ownCloudclient in
your menu > Internet > ownCloudclient.

Upon starting your owncloud-client, you will need to
create a connection.

Click Next.

Welcome To PCLOS-Cloud

http://pclosusers.com/services-signup.php
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Enter the address of the PCLOS-Cloud server:

pcloscloud.pclosusers.com

Uncheck the box "Use Secure Connection"

Enter your username:

Enter your password:

This is the same username and password you used
when you signed up for the PCLOS-Cloud account.
Then click on the "Next" button at the bottom right
corner of the Connection Wizard screen.

If everything went right, you should see the
Connection Wizard status screen.

If you see anything but that big green line saying
"Successfully connected to ownCloud!", press
the "Back" button and check your entries. Otherwise,
press the "Finished" button. Your ownCloud sync
client is now running.

Enjoy PCLOS-Cloud.

Other Benefits

You can also access your PCLOS-Cloud account
from anywhere on the web by going to
http://pcloscloud.pclosusers.com and logging into
your account.

You can also access PCLOS-Cloud in the Dolphin
file manager using the following address:
webdav://pcloscloud.pclosusers.com/remote.php/we
bdav/

Or, you can access PCLOS-Cloud using your
Android or iOS device using the mobile application.
Download Your App Today! Google Play  
Apple App Store  Amazon Appstore

PCLOS-Cloud, simple-to-use  secure  private.

After all, with PCLOS-Cloud, it’s your cloud, your
data, your way.

Welcome To PCLOS-Cloud

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

http://pcloscloud.pclosusers.com
https://play.google.com/store/apps/details?id=com.owncloud.android
http://itunes.apple.com/us/app/owncloud/id543672169?ls=1&mt=8
http://www.amazon.com/ownCloud-Inc/dp/B00944PQMK/ref=sr_1_1?ie=UTF8&qid=1352459188&sr=8-1&keywords=owncloud
http://www.pclinuxos.com
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by Meemaw

Wow! This year has really gone by quickly! I have
barely started even thinking about the holidays, but I
know I need to start getting things done. I hope I can
find the perfect gift for everyone on my list.

Many of us have friends or relatives that are a bit
quirky, and they generally like an unusual gift rather
than the standard. Parnote went to ThinkGeek to
find his, but my favorite “unusual gift spot” is Bits and
Pieces. This site started years ago as a catalog
order company, but now, of course, they have a
website. It has expanded from mostly jigsaw puzzles
to toys and games, lawn art, weather instruments,
gift items and much more. I have found a few I think
are unusual, and all prices are in USD.

We always pray that nothing ever happens, but if
you are stuck in your car, this tool may be just the
thing you need. The Emergency Auto Tool ($9.99)
has a flashlight, seat belt cutter and a hammer to
break a window, just in case of dire circumstances. It
also has a magnet so it can be placed on the side of
the car to make you more visible while you change
that tire. (The catalog has two or three of these in
different styles and sizes.)

If you want to know the temperature, but you don’t
want to mount a regular thermometer to the wall, this
might be just the thing. A Hanging Galileo
Thermometer ($39.99) is a unique way to find the
temperature. The glass
spheres inside the
tube rise and fall
depending on the
temperature.

While we are outside
(or close, anyway), I
know people who like
wind chimes or other
movable art in the
yard. This Rainbow
Windspinner ($69.99)
could be the perfect
addition to a friend’s
yard (below). It is 84
inches tall and 16.5
inches in diameter, so
it won’t be hard to see

Before we go back inside, let’s play! This Crash-
Proof Remote Control Helicopter ($59.99) looks
fun, especially for someone who’s manual dexterity
isn’t great. It is advertised as crash-proof, so it can
be “bashed and smashed” into things without fear of
damage. That is close to my skill level at controlling
one of these things, anyway!

While we are playing, let’s play with something
inside! These Electronic Drumsticks ($24.99) will
let anyone emulate their favorite drummer. They are
13.75 inches long and light up on the ends with
every beat.
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http://www.thinkgeek.com/
http://www.bitsandpieces.com/
http://www.bitsandpieces.com/
http://www.bitsandpieces.com/product/must-have_emergency_auto_tool/multi_function_gadgets
http://www.bitsandpieces.com/product/hanging_galileo_thermometer/weather_instruments
http://www.bitsandpieces.com/product/hanging_galileo_thermometer/weather_instruments
http://www.bitsandpieces.com/product/rainbow_windspinner/solar_wind
http://www.bitsandpieces.com/product/rainbow_windspinner/solar_wind
http://www.bitsandpieces.com/product/crash_proof_rc_helicopter/remote_control_toys
http://www.bitsandpieces.com/product/crash_proof_rc_helicopter/remote_control_toys
http://www.bitsandpieces.com/product/electronic-drumsticks/gifts
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I guess I’m obsessed with the time, but I seem to
have a clock in every room in my house (but oddly
enough, I quit wearing a watch). If you want to give
someone a clock and they are in favor of something
a little different, this may be it. The Rainbow
Umbrella Clock ($9.99) will sit on a table or shelf.

Have you ever wanted to leave a note, but couldn’t
find any paper? Try this LED Message Board
($9.99). Write your message with the stylus, stand it
up with the support, place it where your friend or
loved one will find it and turn it on. Your message will
glow. Dimensions are 7.75 x 8.75 inches.

I have plenty of them, but coffee mugs make good
gifts. This Butterfly Mug ($6.99) changes colors as
it gets hot or cools off.

Bits and Pieces has a whole section of mugs! Some
change colors and some have a different shape or
feature and a few even emit animal noises. Have fun
looking!

While it’s evident that this is my favorite site for
unusual gifts, I do want to visit a few other sites. Not
everyone is into the unusual.

Hubby and I like to play cards. Generally there are
only two of us playing, since the kids have left home,
so we play Pitch and Rummy most of the time. Years
ago we found a rummy style game that is really fun.
We were playing it with two regular card decks and
our friends called it Three-Thirteen. We later found
that it had also been marketed by the Set
Enterprises Game Company, and their version is
called Five Crowns ($12.99). In this game there are
five suits, and you play eleven rounds. Each round
you are dealt a different number of cards (3 the first
round, 4 the next and so on) and a different card is
wild (3’s the first time, 4’s the next and so on up to
Kings). You can only play your cards if you can play
all of them, and everyone after that has one turn to

play as many cards as they can. Your leftover card
values are added and the winner is the one with the
lowest score.

Everyone can always use a new t-shirt. One of my
new shirts this year will be a PCLinuxOS shirt from
the PCLinuxOS Store. My favorite color is blue, but it
is cold out now, so this black one is my chosen shirt
($25.99).

All of us at the PCLinuxOS Magazine hope your
holidays are filled with fun and happiness, and that
you find exactly the right gift for each of your family
and friends.
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http://www.bitsandpieces.com/product/rainbow_umbrella_clock/novelty_clocks
http://www.bitsandpieces.com/product/rainbow_umbrella_clock/novelty_clocks
http://www.bitsandpieces.com/product/led-message-board/desktop_gadgets
http://www.bitsandpieces.com/product/color_changing_butterfly_mug/mugs
http://www.setgame.com/
http://www.setgame.com/fivecrowns
http://www.setgame.com/
http://www.cafepress.com/+pclinuxos+gifts
http://www.cafepress.com/mf/37022330/shirt_tshirt?shop=pclinuxos
http://pclosmag.com/


PCLinuxOS Magazine Page 17

by Paul Arnote (parnote)

Traditionally, Linux users are viewed as a “geeky”
lot. And I’m OK with that, personally. To me, all that
means is that I’m looking for something better than
what the uneducated masses settle on. That’s why I
use PCLinuxOS, instead of Windows or OS X.

This year, most of my selections for the Annual
Holiday Gift Guide will be from one place:
ThinkGeek.com. All the most ingenious, original,
unique gifts befitting a “geek” can be found there. My
remaining choices will come from the official
PCLinuxOS Store.

So, what follows are my 10 choices for holiday gift
giving.

Class IIIa Green Laser Pointer, $39.99

It’s green, not red. As such, it’s about 50x brighter
than a “traditional” red laser. As such, it can be seen
at much greater distances than a red laser. Plus,
since everyone else has a red laser, that makes a
green laser just that much “cooler.” Another nice

feature of this item is that unlike most red lasers out
there that use small (expensive) button batteries,
this laser runs off of two AAA batteries, which are
available just about everywhere and anywhere.

Rock Paper Scissors Lizard Spock Desktop Mug,
$7.99

Do you have a Big Bang Theory fan on your gift list?
(I was thinking of Meemaw when I added this). Well,
here’s a perfect gift for them. The diagram on the
mug helps solve disputes about what move trumps
what move in Rock, Paper, Scissors. And, until the
Big Bang Theory came along, most people never
heard of Lizard or Spock. In fact, I’m betting that the
“inventors” of Rock, Paper, Scissors hadn’t, either. A
search of the internet reveals an individual by the
name of Sam Kass claiming to have invented the
expanded version, on his website.

It goes like this … Rock crushes lizard, Scissors
decapitate lizard, Lizard eats paper, Lizard poisons
Spock, Paper disproves Spock, Spock vaporizes
rock, Spock bends scissors. The 16 ounce (473 ml)

mug is NOT dishwasher or microwave safe, to
preserve the printing on the mug.

Star Wars In Your Pocket, $9.99

Who doesn’t have a Star Wars fan on their holiday
gift list to buy for? I think you’d be hard pressed to
find someone who doesn’t. You would also be hard
pressed to find a cooler, geekier gift than one of
these two key chains… or both of them!

The black one features six memorable lines from
Darth Vader, while the green one features a half
dozen memorable lines from Yoda. Now your Star
Wars aficionado can carry a little bit of Star Wars in
their pocket, whipping it out for use at the most
appropriate (or inappropriate) times.

Plus ... with the first of the new movies due out at
the end of next year ... I'm just sayin' ...

2014 Holiday Gift Guide: Paul's Picks

http://www.linfx.com
http://www.thinkgeek.com/
http://www.cafepress.com/pclinuxos
http://www.thinkgeek.com/product/5a47/
http://www.thinkgeek.com/product/dd59/
http://www.thinkgeek.com/product/1fbb/
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Star Trek TNG Uniform Tee, $19.99

Lay in a new course, Commander Data! The Trekker
on your holiday gift buying list will swoon over this t-
shirt, which is styled after the uniforms worn on Star
Trek: The Next Generation. Captain Jean luc Picard
would be proud. This t-shirt is emblazoned with
screen printed pips indicating rank, as well as
screen printed sparkly communication badges.
Careful wearing the red shirt! You know what
happens to the red shirted crew members – they are
expendable.

Pen-Ultimate 5-in-1 Geek Pen & Stylus, $9.99

Want to talk about the ultimate geek pen? A pen that
does EVERYTHING? Here it is. It’s a pen that
writes. It’s a white flashlight. It’s an ultraviolet
flashlight. It’s a red laser pointer. It’s a capacitive
stylus. What more could you possibly want from a
pen?

The pen is refillable. When you’re done writing on
paper, unscrew the lower half of the unit, flip it
around, and screw it back in. Now you have a stylus
the will work on most tablets and smartphones.

Doctor Who TARDIS Door Cling, $59.99

Having been aired continuously, either as new
shows or in syndication, for the past 51 years, the
fan base for Doctor Who is ENORMOUS. Chances
are high that you have a Doctor Who fan on your
holiday gift list.

Any self-respecting Doctor Who fan would be
ecstatically happy to get this TARDIS door cling.
With it, they can transform any 36” x 80” (91.5 cm x

203 cm) door (closet door, bedroom door, entry door,
office door, etc.) into their own TARDIS portal. The
PVC door cling can be cut down to fit any odd size
door, if necessary. It can also be taken down and
reapplied over and over again.

Infinite Dungeon Corridor, $24.99

If you remember the “infinity mirrors” from the 1980s,
you’ll certainly appreciate this ThinkGeek exclusive
reproduction. ThinkGeek has transformed the old
classic into an endless, infinite dungeon corridor,
complete with flickering torches for that authentic
look and feel. It is designed to sit on your desk, or to
hang on your wall. This makes a perfect gift for
anyone who likes dungeons, corridors, infinity,
castles, D&D, and more. The Infinite Dungeon
Corridor runs on three AA batteries.

PCLinuxOS Men’s Value T-Shirt, $13.99

Show your PCLinuxOS pride, and help spread the
word about PCLinuxOS at the same time. Made of
midweight 100% cotton fabric, this t-shirt is perfect
casual wear for a warm summer day. Better yet, get
one for every person on your holiday gift shopping
list and REALLY help spread the word about
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http://www.thinkgeek.com/product/16d9/
http://www.thinkgeek.com/product/18de/?pfm=HP_ProdTab_1_2_WhatsNew_18de
http://www.thinkgeek.com/product/11fb/
http://www.thinkgeek.com/product/16a2/
http://www.cafepress.com/mf/37022118/whtshirt_tshirt?shop=pclinuxos&productId=421198461
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PCLinuxOS. A portion of the proceeds from the sale
of this item goes to help support PCLinuxOS.

PCLinuxOS Boxer Shorts, $14.99

Keep PCLinuxOS next to your heart with these
100% lightweight cotton boxers. Great to use for

underwear or sleepwear. A portion of the proceeds
from the sale of this item goes to help support
PCLinuxOS.

PCLinuxOS Mouse Pad, $12.99

Give your favorite PCLinuxOS user – or yourself –
the gift of a mouse pad emblazoned with the logo of
the best Linux distro around. A portion of the
proceeds from the sale of this item goes to help
support PCLinuxOS.

Summary

Regardless of your religious beliefs or holiday
traditions, these are some gift suggestions to help
fulfill your holiday gift buying needs.

Happy Holidays, from all of us at The PCLinuxOS
Magazine. May you have peace and harmony in
your life.

International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark

Czechoslovakia

Italy

Poland

Brazil
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http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
http://www.cafepress.com/pclinuxos.421199938
http://www.cafepress.com/pclinuxos.421200225


PCLinuxOS Magazine Page 20

Screenshot ShowcaseScreenshot Showcase

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

The place where breaking news,
BitTorrent and copyright collide

Posted by coffeetime, November 15, 2014, running Openbox.

http://www.cafepress.com/pclinuxos
http://torrentfreak.com/
http://www.pclinuxos.com
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by YouCanToo

Wow, it’s already that time of year once again. A time
to reflect on what was, and make way for the New
Year to come. A time to share with our family and
friends. So without any great fanfare, here are my
10 gift choices for the 2014 holiday season.

Blow Up Your Phone! $27.00

Pop your smartphone into this handy projector and
unleash the potential of your cramped screen by
projecting it onto a wall. The retro-styled projector
housing of corrugated cardboard is easy to
assemble, includes intuitive icons to aid best
projection results, and provides natural sound
amplification. A sticky silicone pad inside the back
compartment accommodates any phone up to 3 x
5.5 inches and keeps it in place. Slide the back
compartment in and out to focus the image. The
glass lens magnifies your phone's screen image
without the need for an additional power source, but
the back compartment has two slots to
accommodate your phone charger or speakers so
you won't run out of juice halfway through that
YouTube cat marathon.

Smartphone Film Scanner $57.00

Smart phones have made photography easier and
more accessible than ever before – but they've also
left generations of photographic memories lingering
in boxes and closets. But with this tool, anyone can
easily welcome those favorite pictures into the 21st
century. A great way to preserve family photos, or as
a tool for photographers who prefer working with
film.

Geeky Binary Number Wall Clock $28.95

It's time to show off your favorite art, photos, and
text with a custom round wall clock from Zazzle
(bottom, center). Featured in two sizes, this wall
clock is vibrantly printed with AcryliPrint®HD process
to ensure the highest quality display of any content.
Order this custom round wall clock for your walls or
give to friends and family as a gift for a timeless
treasure.

Beer Flavored Potato Chips 9oz. $5.00

The only reasons I can think of to eat beer-flavored
potato chips are that I like beer and I like potato
chips. I don't like dipping my potato chips in my beer,
because occasionally one absorbs too much liquid
and breaks off into the bottom of the glass.

28-Port USB MondoHub $59.99

ONE USB HUB TO RULE THEM ALL

The 28-Port MondoHub features 24 USB 2.0 ports
and 4 USB 3.0 ports to give you ample space to
charge your devices. With a high-capacity 4 amp
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http://www.uncommongoods.com/product/smartphone-projector
http://www.uncommongoods.com/product/smartphone-film-scanner?utm_medium=cpc&utm_source=google&country=US&country=US&adpos=1o1&creative=50023606977&device=c&matchtype=&network=g&gclid=CM7RjZqu5MECFZRgfgodUq8AOA
http://www.zazzle.com/geeky_binary_number_system_wall_clock-256089275297248070
http://www.sprecherbrewery.com/store/details.php?prodId=260&category=8
http://www.dudeiwantthat.com/exclusives/28-port-mondohub.asp
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power adapter, you can manage a growing collection
of USB-enabled devices like never before.

MondoHub features 4 SuperSpeed 3.0 USB ports
and can recharge devices or transfer data at
lightning fast speeds.

CuBox-i Mini Computer for XBMC player,
Android TV Box and Linux $79.80

It's a straight up cage fight for the title of World's
Mini-est Computer. Now, measuring in at 2" x 2" x 2"
– about the size of an Everlasting Gobstopper – the
design and development firm SolidRun brings us the
CuBox, allegedly the smallest desktop in existence
and a neat Little Computer That Can. It's kind of
cute. I may even go so far as to call the CuBox
adorable.

Android Mini MK802 Google TV Box HD IPTV
Player, 1GB $36.90

It outputs the video to TV via HDMI, a short HDMI
cable is included, and it requires your TV to have a
HDMI input. It has a regular USB port, so you can
connect your USB mouse or keyboard here, and you
can also connect a 2.4GHz wireless mouse and
keyboard dongle

Phantom Keystroker V2 $29.98

Attach this evil prank device to your victim's
computer and it makes random mouse movements
and types out odd garbage text and phrases

Switches on the side choose between keyboard
garbage typing, caps lock-toggle, annoying mouse
movements or all three

The adjustment dial sets the duration between
annoying "events"

It works on any OS (Caps-Lock toggle does not work
on the Mac. May not work on some Linux systems
depending on configuration.)

The victim's computer requires a USB port

Bacon Flavored Hot Sauce $6.00

Guys love hot sauce. Guys love
bacon. Put them together and you’ve
got a winner. Here’s a treat that’s sadly
been missing in the past, but they’ve
fixed the glitch and now he can enjoy
two of his favorite things at the same
time.

RFID Wallet $16.00

Think you're safe from identity theft
with your wallet tucked under your arm
or in your back pocket? Better think
again.

The truth is from a distance anyone with the right
equipment can read and steal whatever content they
want from your wallet. These criminals can get your
credit card information, find out your name, address,
nationality...you name it!

That’s right, a bad guy can walk by you with an RFID
scanner, scan your credit cards, passport, anything
with a bar code type RFID tag -- and do so without
you even knowing. Ten minutes later, he could have
wiped out your bank account or maxed out your
cards.

Have a great holiday season.
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http://www.dudeiwantthat.com/gear/computers/cubox-the-little-computer-that-can.asp
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as told to Smileeb

How old are you?
47.

Married, single or what?
Divorced.

Children, grandchildren?
One lovely boy, David Oliver (1 year, 7 months).

Retired or working and for how long and at
what?
Thankfully, I'm still working. I'm an IBM mainframe
console operator for a Fortune 500 company, with 11
years of experience.

What is the area you live in like.
Weather, Quietness, Scenery?
I am currently living in an urban jungle
where it's really hot half the year, and
really cold the other half. But I've lived
in 6 different states, so the next move
may always be around the corner...

Are you handy with your hands and
have any hobbies?
I own 1,200 classical music CDs
(ripped as FLAC files), and love
Beethoven the most. I also listen to
some heavy metal bands, and some
Allan Parsons's music. I'm also a

Science-Fiction fan and build computers for friends,
family and myself.

What is your education level?
Unfinished college, School of Mathematics and
Computer Sciences.

Do you like to travel, go camping?
I love living in different areas of the country …
different scenery, food, people, accents … I also
love it when I go shopping, even when I end up not
buying anything.

What caused you to try Linux and join this
forum?
I needed a stable OS, and a safe filesystem to store
my data. The Linux ecosystem gave me both. I've
been a community member, under different names,
for 9 years. I really, really love the rolling release
philosophy of PCLinuxOS. Also, Texstar and the

My two pets, Trina (salt and
pepper), and Yina (white),

both female.

My place at work... all running
Windows, though.

The three computers where PCLinuxOS is installed at
home (game station and primary computer, download
station, and media center at living room).

PCLinuxOS Family Member Spotlight: izto
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others in the development team have no rush to
embrace new technologies until they are proven
necessary, and are stable. That won't get them
headlines, but gives them faithful users.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
smileeb in the PCLinuxOS forum expressing your interest.

Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Linux Docs
Linux Man Pages

Posted by elana, November 2, 2014, running MATE.

PCLinuxOS Family Member Spotlight: izto

http://www.pclinuxos.com/?page_id=10
http://www.linuxfoundation.org/
http://www.die.net/
http://www.opensource.org/
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by Khadis

At the very beginning stage of learning graphic
design, I learned to design a piece of writing paper
from a “how-to” book for kids. It was fun, although
the book was really intended for elementary
students or kids of that age. And now, I will show you
about what I learned. Then you can practice it both
for yourself and your kids (if any) or the kids around
you.

• Open up your Inkscape and create a rectangle
width= 21 cm height= 29.7 cm (A4 size) or any size
that you like.

• Use the Gradient Tool and drag it from the top to
the bottom of your rectangle. Click on the top handle
(the box shape) and click on the yellow color on your
color pallet. Add one or two more nodes by double-
clicking the gradient line to create a yellow-to-green
gradient.

• Click on that new node(s), and choose 'green' as
the color. You can move the new node(s) to create a
better, smoother gradient.

• Create another rectangle and fill it with ‘white’ color.
I used width = 16.5 cm and height = 24 cm. Place it
in the middle of previous rectangle using Align and
Distribute.

• Create some circles, fill them with ‘white’ color,
without stroke, and place them on top of the white
rectangle. See the picture below. In the picture, I still
have black strokes. It’s only to describe that I
created the circles. Of course, later, they can be
easily removed.

• If you wish, you may group or unify those circles
with the rectangle using Path > Union. Don’t forget
to remove the stroke if you still have it.

• Create some lines and arrange them like in the
picture below. You may color them too. I used 1.50
px as the line width.

• Finally, you can put text or images to decorate your
design. I used some PNG images that were taken
randomly from Google (next page, top left).

• This design can be used as a photo frame too. You
can also set the gradient as much as you like. If you

Inkscape Tutorial: Design Your Own Paper
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plan to teach basic Inkscape to your child or children
around you, this simple tutorial will fit your needs.

Screenshot ShowcaseScreenshot Showcase

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxos-magazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Reach Us On The Web

linuxfordummies.org

There Are No Stupid Questions
Where *BSD & Linux Converge

Posted by ff103, November 27, 2014, running KDE.
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http://pclosmag.com
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http://linuxfordummies.org/
http://forum.fossconvergence.org/index.php


PCLinuxOS Magazine Page 27

by Jeremy Gillula

At a technology conference this past Wednesday
(late October), Rupert Murdoch, chair of 21st
Century Fox, argued that major media companies
should develop their own video streaming service
that could compete with Netflix and Amazon. His
comments likely stemmed from worries that Netflix
and Amazon are starting to gain more and more
leverage over the traditional content providers.
Given that other streaming services are having a
tough time competing (Verizon’s foray into video
streaming, Redbox Instant, is shutting down), those
worries are well-founded.

Media companies don't have a great track record of
competing head-to-head against specialized
technology firms at the best of times, and in this
case they would be starting from far behind.

Fortunately, there’s one move media companies
could make that would set apart any new video
streaming service they develop: they could ditch the
DRM.

It's a pretty radical notion for traditional content
providers, but it makes a lot of practical sense. The
official reason for locking media up with DRM is to
prevent it from being copied, on the theory that
distributing content that can be copied will mean
fewer sales of that content. But as we saw with the
music industry, that argument doesn’t hold much
water. Even though all of the major digital music
stores have ditched DRM, digital music sales
continue to grow. And this justification makes even
less sense for locking down streaming video with
DRM. After all, while people listen to the same songs
over and over again, that's less true for TV shows
and movies. After you watch an episode of a TV
show, you often don’t watch it again: you move on to
the next one. This means that even though someone
might be able to download and re-watch a TV show
they watched this week, they’ll still continue to pay a
convenient subscription to be able to watch next
week’s TV shows.

Another reason for using DRM is to prevent
competition. We’ve seen e-books that can only be
read by certain e-readers, printers that only accept
ink cartridges from the same brand, and even
garage door openers that only work with remotes
from the same manufacturer. But in all of these
cases the manufacturer is selling two or more
different products. They want to make sure that once
a customer buys one of their products (an e-reader,
a printer, or a garage door opener) they’ll also be the
only source for a customer who wants to buy
matching accessories (e-books, ink cartridges,
remotes). But this reasoning doesn’t make sense for
media companies who want to sell streaming video,

because they only have one product: the content. In
fact, by ditching DRM media companies can
guarantee that as many people as possible will be
able to sign up for their service.

After all, DRM introduces unnecessary engineering
complications. A streaming service without DRM is
much easier to develop apps for, can be more easily
integrated into smart TV products, and can
otherwise foster all kinds of add-on innovation. For
example, offering video DRM-free would make it
easy for volunteer communities to add subtitles,
especially in languages for which it wouldn’t be cost-
effective to pay for professionals. If you spoke a
foreign language, which streaming video service
would you choose: the locked-down one you can’t
understand? Or the DRM-free one which has
subtitles? (Plus it reduces the chances of DRM
introducing unnecessary security risks into
customers’ devices.) All of these opportunities
means more potential subscribers, and that
translates into more revenue, not less.

As we’ve been saying all along, interoperability and
ease-of-use are the key factors that determine how
someone will choose to access content. Lack of
DRM makes it easier for customers to access
content when they want, where they want, using the
device they want. If the major media companies
want to take back control over their work from

Dear Rupert Murdoch:
Want To Compete With Netflix? Ditch DRM!

https://www.eff.org/deeplinks/2008/08/kindle
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https://www.eff.org/cases/lexmark-v-static-control-case-archive
http://arstechnica.com/tech-policy/2009/12/what-is-drm-doing-in-my-garage/
http://arstechnica.com/tech-policy/2009/12/what-is-drm-doing-in-my-garage/
https://www.eff.org/deeplinks/2007/04/sonys-latest-drm-backfire
https://www.eff.org/deeplinks/2007/04/sonys-latest-drm-backfire
https://www.eff.org/deeplinks/2014/05/how-drm-harms-our-computer-security
https://www.eff.org/deeplinks/2005/12/updated-sony-bmg-drm-spotters-guide
https://www.eff.org/deeplinks/2005/11/sony-bmg-rootkit-drm-nutshell
https://www.eff.org/deeplinks/2014/10/adobe-spyware-reveals-again-price-drm-your-privacy-and-security
https://www.eff.org/deeplinks/2009/04/protest-kindle-drm
https://www.eff.org/deeplinks/2008/01/2008-drm-continues-punish-paying-customers
https://www.eff.org/deeplinks/2006/10/yahoo-music-exec-drm-total-failure
https://www.eff.org/deeplinks/2005/12/beginning-end-music-drm
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companies like Amazon and Netflix, they would be
wise to release their content directly to
customers—without DRM.

Reprinted from Electronic Frontier Foundation, under
Creative Commons Attribution license. The original
article appears here.

Screenshot ShowcaseScreenshot Showcase

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Linux Training
Courses & Classes

Posted by Taco.22, November 4, 2014, running Openbox.

Dear Rupert Murcoch: Want To Compete With Netflix? Ditch DRM!

http://pclostalk.pclosusers.com
mailto:pclinuxos.mag@gmail.com
http://www.beginlinux.com/
http://www.dosgamesarchive.com/
https://www.eff.org/deeplinks/2014/10/dear-rupert-murdoch-want-compete-netflix-ditch-drm
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 192, average score 135.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201412/files/2014-12-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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Download Puzzle Solutions Here

1. In the US, a time for many people to give thanks for
what they have.

2. commemorates the establishment of the first European
settlement in Sydney

3. In the US, the anniversary of the publication of the
Declaration of Independence in 1776.

4. In the UK, it marks the anniversary of the discovery of a
plot organized by Catholic conspirators to blow up the
Houses of Parliament in London in 1605.

5. In many countries, a celebration of the new year (first
day of the Gregorian calendar).

6. In many countries, a celebration of spring.
7. In Christian beliefs, it celebrates Jesus Christ's

resurrection.
8. In the UK, a day when employers distributed money,

food, cloth (material) or other valuable goods to their
employees.

9. In the US, originally organized to celebrate various
labor associations' strengths of and contributions to the
United States economy.

10. commemorates Canberra’s official founding in 1913.
11. In many countries, a day to celebrate Irish culture.
12. to remember the Jewish people’s deliverance from a

royal death decree around the fourth century BCE, as
told in the Book of Esther.

13. in many countries, commemorates the sacrifices of
people in armed conflicts.

14. celebrates the defeat of the French army during the
Battle of Puebla in Mexico on May 5, 1862

15. In the US, the anniversary of the signing of the
armistice, which ended the World War I hostilities
between the Allied nations and Germany in 1918.
Veterans are thanked for their services to the United
States on Veterans Day.

16. also known as the Spring Festival, it lasts for about 23
days.

17. In the US, a festival of romantic love.
18. a week-long holiday honoring African culture and

traditions.
19. In Russia, an occasion for many Russians to

demonstrate national pride: many people pay tribute
to prominent Russians.

20. marks the anniversary of the end of World War I

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle:
December 2014 Holidays

http://pclosmag.com/html/Issues/201412/files/2014-12-PuzzleSolutions.pdf
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Armistice Day
Australia Day
Boxing Day
Canberra Day
Chinese New Year
Christmas
Cinco de Mayo
Easter
Guy Fawkes Day
Hanukah
Independence Day
Kwanza
Labor Day
May Day
New Year's Day
President's Day
Purim
Remembrance Day
Rosh Hashana
Russia Day
St. Patrick's Day
Thanksgiving
Valentine's Day
Veterans Day

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Holiday Word Find

http://pclosmag.com/html/Issues/201412/files/2014-12-PuzzleSolutions.pdf
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by elana

How about A+?

PCLinuxOS puts Microsoft and Apple to shame.

I've only been using this OS for about eight months.
It is the first Linux distribution that I have tried, and
will probably be the only one that I would ever need.

PCLinuxOS works for you with
minimum effort … as opposed
to spending endless, agonizing
hours and large sums of
money (on additional software
like AV, cleaners,
defragmentation, etc., etc.)
trying to get a dysfunctional
platform to marginally perform.
Not to mention that the use of
which allows for the collective
of world government spy
agencies, equipment
manufacturers, ISP's,
telephone and satellite
providers, software giants, and general hackers to
know more about your personal affairs than you do. I
intend to fight back.

Dell built my old single core machine in 2002. I lost it
last week to a dead power supply and it went to a
shop for repair. When I got it back, PCLinuxOS was
working just fine but the bench tech installed some
diagnostic software on the Windows XP side of the
drive that ate up too much space. Needless to say,
Add/Remove Programs in the Control Panel could
not uninstall it and neither could Microsoft using
Microsoft Fix-it. I spent three days running anti-virus,
cleaning, and utility maintenance software while I

diligently hacked files and the registry. It is working
properly now, but the point is that it was a time-
consuming pain in the butt.

I am now ready to lose Windows XP, except that I
still need it to scan and fax (CUPS is not cutting it)
for an Epson All-In-One printer (Workforce 545). This
will be my next Linux project. (It’s) probably some
driver that isn't included in the repository.

Anyway, Windows 10 is just
another programming array of
Microsoft spyware. Probably
the best of the lot, and
Microsoft is running scared.
People like me helped to build
that Silicon Valley Empire and
we can rip-it down as well. I
refuse to buy a machine that
runs a proprietary OS.
PERIOD. Let Dell and HP
chew on that for a while. I
doubt that they'll go down with
the Microsoft and Apple ship.
That is probably why Bill
Gates is pushing vaccinations

and World Health Organization (WHO) objectives
now. He is praying to the God of Money, and serving
his royal elite central-banking masters. Surely they
must expect resistance.

Many, many thanks to you people in the PCLinuxOS
forum for helping those of us without the technical
knowledge to provide that assistance with
PCLinuxOS. It is an exceptional work of open-
source software, programming art, and a lifeline to
humanity.

Three thumbs up and a big smile. Many thanks for
PCLinuxOS!

Donate To PCLinuxOS
Community Supported.

No Billionaires/Millionaires.
No Corporate Backing Or Funding.

Click here to make a one-time donation
through Google Checkout.

Or, click one of the amounts down below
to make a monthly, recurring donation.

DOWNLOAD

Mate Desktop

Testimonial: Report Card On PCLinuxOS

http://www.pclinuxos.com/?page_id=7
https://gumroad.com/pclinuxos#LXoq
https://gumroad.com/pclinuxos#FGqC
https://gumroad.com/pclinuxos#zpNB
https://gumroad.com/pclinuxos#MPxaN
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by daiashi

About The Game

In a world ravaged by global warfare, small pockets
of survivors scratch out a meagre existence, living
off the remains of a shattered civilization. Society
has been reduced to a tribal state, where rank and
social standing is based on one thing and one thing
only: death races!

Cracking Sands is an action-packed racer featuring
a band of merry lunatics driving small vehicles fitted
with big guns. Your trigger finger will be tested just
as much as your straight racing skills. Like the
saying goes: if you can’t go around something (or
someone), you go through them instead. Mix and
match pieces to create your own custom character
and kart, then equip it with all the machine guns,
missiles, mines and exotic implements of doom it
can carry. Buy new parts to tweak your character
and kart even further.

System requirements

Fully updated PCLinuxOS. This is a good size
download, weighing in at 533 MB.

Hardware

None really, since it was a mobile port. I run it on
high with a Toshiba Chromebook having 2 GB of
DDR3 RAM and a 1.4 Intel dual core with no
problems.

About The Company

Polarbit is an independent developer and publisher
of video games and game development technology.

Founded in 2005, Polarbit has developed or
published more than 30 titles for smartphones,
Mac/PC and consoles. Notable titles include Raging
Thunder 2, the Reckless Racing series, Crash
Bandicoot Nitro Kart 2 and MLB World Series 2010.

A total of more than 80 million downloads of Polarbit
developed and published titles stand as testament to
their experience, dedication and uncompromising
attitude towards quality.
Although you can create an online profile, there
doesn't appear to be a multiplayer version as of yet.
There is a decent campaign level to enjoy.

I chose to do the review on this game to give
everyone something to play that wasn't quite so
graphics intensive. I have constantly had to upgrade
in the past years and spend tons of money to play
the latest and greatest games out there, only to be
behind before I even added the hardware to the
shopping cart. It’s nice to see these great games
coming to Chrome so anyone can enjoy them. From
what I have read, Google is planning to port most of
the Android apps and games to Chrome through
their Web Store. I hope you enjoy this game. It’s not
much, but I believe it is showing possibly a shift or at
least a welcome addition to how we play PC games.

Some Gameplay Screenshots

Game Zone: Cracking Sands Racing
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Getting It To Run

Install Chrome browser from the PCLinuxOS
repositories, then search on the webstore for
Cracking Sands Racing. Hopefully they will add
multiplayer capability in the near future.

Screenshot ShowcaseScreenshot Showcase

Posted by ferry_th, November 13, 2014, running KDE.

Game Zone: Cracking Sands Racing

http://www.jupiterbroadcasting.com/tag/linux-action-show/


PCLinuxOS Magazine Page 35

Posted by Crow, November 23, 2014, running KDE. Posted by Meemaw, November 1, 2014, running Xfce.

Posted by francesco bat, November 18, 2014, running KDE. Posted by MERTZ, November 22, 2014, running KDE.

More Screenshot Showcase




